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1 About this Manual 

1.1 Oracle Financial Services Analytical Applications Infrastructure 
Overview 

Oracle Financial Services Analytical Application Infrastructure (OFSAAI) is an analytical 

application platform which has been architected to be multi-tiered and open-systems compliant. 

OFSAAI is fully web-enabled. It’s a 100% thin-client, browser-based interface with zero foot print 

which dramatically reduces the cost of application deployment. All OFSAAI processes, including 

those related to business, are metadata-driven, thereby providing a high degree of operational and 

usage flexibility, and a single consistent view of information to all users. 

OFSAAI product suite includes a rules-framework designer engine, Unified Metadata Manager 

which has a semantic layer of metadata abstraction that is common over both relational and OLAP 

repositories.  

1.2 Oracle Financial Services Basel Regulatory Capital Analytics Overview 

Compliance to the Basel accord is a mandated business requirement for financial institutions in 

most jurisdictions around the world.  Oracle Financial Services Basel Regulatory Capital Analytics 

Release 6.0.0.0.0 provides the customer with a reporting-cum-information framework which can be 

used for generating reports and viewing information relevant to the capital computations and other 

aspects of the Basel framework. 

1.3 Scope 

The information contained in this document is intended to give you a quick exposure and an 

understanding of the installation procedures to: 

 Install the Oracle Financial Services (OFS) Basel Regulatory Capital Analytics v6.0.0.0.0 
for the first time, in the following environment: 
 

o Standalone installation (without OFSAAI v7.3.2.2.0) 
o With Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) 

v7.3.2.2.0 
 

 Upgrade released version of OFS Basel Regulatory Capital Analytics v5.3 to OFS Basel 
Regulatory Capital Analytics v6.0.0.0.0. in the following environment: 
 

o Standalone installation (as OFS Basel Regulatory Capital Analytics v 5.3 caters to 
only the standalone installation option). 

The topics are designed in the order of priority with related procedures to assist, configure, and 

manage the administrative tasks effectively.  

1.4 Organization of the Manual 

The Installation Manual is organized into the following chapters: 

 Prerequisites section identifies the hardware and base software environment that is 
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required for successful installation and functioning of OFS Basel Regulatory Capital 

Analytics Version 6.0.0.0.0. 

 Installing the Application section details the pre-installation activities followed by a step-by-

step instruction on the various installation options. 

 OFS Basel Regulatory Capital Analytics 6.0.0.0.0 Configuration section details the steps 

that should be performed after the successful installation of the OFS Basel Regulatory 

Capital Analytics Version 6.0.0.0.0. 

1.5 Conventions Used in this Manual 

 References to sections or chapters in the manual are displayed in Italics.  

 Screen names are displayed in the following manner: 

            Introduction screen 

 Options and buttons are displayed in Bold. 

 Notes are displayed as follows: 

Note: 

It is important that the password should be 6 characters long. If you do not adhere to this pre-

requisite, you will see a system message that reads Password must be at least 6 

characters long. 
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2 Prerequisites 

2.1 Environment 

Installation of OFS Basel Regulatory Capital Analytics Version 6.0.0.0.0 requires the Oracle 11g 

R2 (11.2.0.2.0) version, to be installed. OFS Basel Regulatory Capital Analytics works in a 

standalone environment, that is, without OFSAAI v7.3.2.0.0 installed. Ensure OBIEE 11.1.1.6.6 on 

any supported operating system is configured after installation.  

OFS Basel Regulatory Capital Analytics also works in case OFSAAI v7.3.2.2.0 is available. In 

such a case, the installation process requires certain environmental variables to be set prior to 

beginning with the installation. For more information on the latest updates on hardware or software 

requirements, refer to the OFS Basel Regulatory Capital Analytics v 6.0.0.0.0 Release Notes. For 

more information on the latest updates on for the environment variables, refer to the OFSAAI 

v7.3.2.2.0 Installation Manual. 

2.2 Front-End Access 

 Internet Explorer 8.0/9.0 

 Java Plug-in 1.6.0_21 

 Acrobat Reader 8.0 

 The screen resolutions supported are 1024*768 and 1280*1024 

NOTE: 

Ensure that Java Plug-in is enabled in the browser settings. 
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3 Installing the Analytical Application 

As stated earlier, there are three scenarios in which OFS Basel Regulatory Capital Analytics can 

be installed which are as follows: 

 Installation of OFS Basel Regulatory Capital Analytics without OFSAAI. This is will be 

treated as a standalone installation. 

 Installation of OFS Basel Regulatory Capital Analytics and with OFSAAI and with the OFS 

Basel Regulatory Capital Application 

 Installation of OFS Basel Regulatory Capital Analytics with OFSAAI and without OFS 

Basel Regulatory Capital Application. 

3.1 Pre-installation Activities  

Following is the pre-installation checklist to ensure readiness to start installing OFS Basel 

Regulatory Capital Analytics: 

 Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) v7.3.2.2.0 must 

be successfully installed on Oracle 11gR2 (RAC) (11.2.0.2.0), if standalone installation is 

not preferred. 

 If OFSAAI installation is on a multitier environment, then execute the following command 

in the DB Layer terminal (applicable for with OFSAA installation). 

o chmod -R 777 < ftpshare folder >  

 Navigate to ftpshare folder and set the umask as follows, to ensure that the new files 

created will have 666 file permissions (applicable for with OFSAA installation). 

o cd < ftpshare folder >  

o umask 0000 

 The Config and Atomic Schema should be two distinct oracle database users. 

 The Information Domain schema uses the tables from the configuration schema. To create 

a new information domain, execute the file <Infrastructure Database Layer Install 

Directory>/config_table_privileges_for_atomic_user.sql from the Infrastructure config 

database, before creating the new information domain. These privileges should be given 

to the Production Schema, essentially all the Atomic Schemas (applicable for with OFSAA 

installation). 

 Add an Atomic Schema TNS entry to TNSNames.ora. 

 The following grants should be present for a Oracle database user for Config Schema 

which is applicable for standalone installation: 

o grant create session to <CONFIG_USER>; 

o grant create ANY INDEX to <CONFIG_USER>;  

o grant create PROCEDURE to <CONFIG_USER>;  
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o grant create SEQUENCE to <CONFIG_USER>;  

o grant DEBUG CONNECT SESSION to <CONFIG_USER>;  

o grant create TABLE to <CONFIG_USER>;  

o grant create VIEW to <CONFIG_USER>;  

o grant select on sys.v_$parameter TO <CONFIG_USER>; 

o grant unlimited tablespace to <CONFIG_USER>; 

 The following grants should be present for a Oracle database user for Atomic Schema: 

o grant create session to <ATOMIC_USER>; 

o grant create ANY INDEX to <ATOMIC_USER>;  

o grant create PROCEDURE to <ATOMIC_USER>;  

o grant create SEQUENCE to <ATOMIC_USER>;  

o grant DEBUG CONNECT SESSION to <ATOMIC_USER>;  

o grant create TABLE to <ATOMIC_USER>;  

o grant create VIEW to <ATOMIC_USER>;  

o grant select on sys.v_$parameter TO <ATOMIC_USER>; 

o grant query rewrite to <ATOMIC_USER>; 

o grant create materialized view to <ATOMIC_USER>; 

o grant create trigger to <ATOMIC_USER>; 

o grant unlimited tablespace to <ATOMIC_USER>; 

 Copy the entire OFS Basel Regulatory Capital Analytics v6.0.0.0.0 installer download 

directory to the server location (including the Data Model directory). Provide read, write, 

and execute permission to all the files present in this directory (applicable for with OFSAA 

installation). 

 Specify the log file path and name in the log4j.xml. Update the “value” attribute marked in 

the following: 

<?xml version="1.0" encoding="UTF-8" ?> 

<log4j:configuration 

xmlns:log4j="http://jakarta.apache.org/log4j/"> 

<appender name="ConfigReveleusFileAppender" 
class="org.apache.log4j.RollingFileAppender"> 

 <param name="file" value="/<installer components copied 
directory>/installer.log"/> 

<param name="Append" value="true"/> 

 Set the java path in .profile for standalone installation. 

 Ensure the path given in the log4j.xml file has read, write, or execute permissions. 

 Execute the embedded WITHOUTOFSAA.sql file in the Configuration Schema (for 

standalone installation): 



 
Installation Manual 

Oracle Financial Services Software Confidential - Restricted  
 

WITHOUTOFSAA.sql
 

 Execute the following scripts in the existing Configuration Schema (this is applicable only 

for an upgrade activity): 

WITH OFSAAI: 

o Update the ##INFODOM## to information domain name and execute the insert 

script in Configuration Schema. 

o INSERT INTO SETUPINFO (APPNAME, DSNID, APPVERSION, PATCHVERSION, 

PATCHDATE) VALUES ('BASEL_ANALYTICS',’ ##INFODOM##’, '5.3', '5.3', 

sysdate); 

           WITHOUT OFSAAI: 

o INSERT INTO SETUPINFO (APPNAME, DSNID, APPVERSION, PATCHVERSION, 

PATCHDATE)VALUES ('BASEL_ANALYTICS', 'BASEL_INFO', '5.3', '5.3', sysdate); 

 If the OFS Basel Regulatory Capital Analytics is being installed with OFS Basel 

Regulatory Capital application v6.0.0.0.0, then the OFS Basel Regulatory Capital Analytics 

data model needs to be merged with the OFS Basel Regulatory Capital application 

v6.0.0.0.0 data model and then used for model upload. 

Note:  

If OFS Basel Regulatory Capital Analytics is installed with OFSAAI and without OFS Basel 

Regulatory Capital application, then all the steps provided in this section are applicable, except 

model upload which should be processed using OFSAAI by generating the ERwin xml file 

(repository mode).  

For standalone installation, the model needs to be forward engineered to the atomic schema using 

ERwin and the triggers created should be dropped. 

3.2 OFS Basel Regulatory Capital Analytics Version 6.0.0.0.0 in Standalone 
Environment 

3.2.1 Procedure for Upgrade from Basel Analytics 5.3 to Basel Analytics 6.0 

This section is applicable for users upgrading from OFS Basel Regulatory Capital Analytics 
version 5.3.0.0.0 (Basel Analytics 5.3) to OFS Basel Regulatory Capital Analytics version 6.0.0.0.0 
(Basel Analytics 6.0).  

Pre-Upgrade Activities 

Prior to the upgrade, take a back up of the existing Atomic Schema and related OBIEE objects 

(Repository, Images, and Catalog file) that is upgraded. This can be used to restore the application 

in case of any failures during the upgrade.   

Upgrade Activities from OFS Basel Regulatory Capital Analytics 5.3 to 6.0 

The following steps need to be performed by the user before proceeding with installation.  
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Database Changes 
 

 Execute the embedded MATERIALIZED_VIEW_FCT_NON_SEC_EXPOSURES.txt file in 
the Atomic Schema. 
 

MATERIALIZED_VIEW_FCT_NON_SEC_EXPOSURES.txt
 

 

 Scripts in the path <kit copied area>/Pre_model_scripts needs to be executed in the 
following order: 

 

1. Atomic_create\Pre_model_create_backup_tables.sql 

2. Atomic_insert\Pre_model_delete_data.sql 

3. Atomic_create\Issuer_type_to_party_type_lookup_tables.sql 

4. Atomic_insert\LOOKUP_ISSUER_TYPE.sql 

5. Atomic_insert\LOOKUP_BASEL_ISSUER_TYPE.sql 

6. Atomic_create\drop_materialized_view.sql 

Alternatively, the user can execute compile.sql in the Atomic Schema, which is present under the 

Pre_model_scripts folder. 

Data Model Changes  
 
If the Data Model is not customized, then the steps followed by the upgrade installer are: 
 

1. Atomic scripts are executed.  

The new RPD and Catalog needs to be deployed manually. 
 
If Data Model is customized, then it is suggested to: 
 

1. Open customized and out of box models using ERwin Data Modeler tool.  

2. Go to "Tools" and select "Complete Compare". 

3. Select the existing Basel Data model on Left Model, in the Compare window. 

4. Select the extracted Basel Data model on Right Model. 

5. In "Type Selection" check "Subject Area". 

6. In "Advanced" option, un-check ALL except "Auto Close Database/Script Models" 

and click “Compare”. 

7. Resolve differences by applying all the changes mentioned in the Basel_Datamodel-

5.3-6.0_changes.xls file. These are the changes from Basel Analytics 5.3 to Basel 

Analytics 6.0 upgrade. 
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Basel53_Analytics_6
0_Analytics_Difference.xlsx

 

8. Click "Finish". 

9. Save the file as XML in "AllFusion Repository Format".  

Example: basel_analytics_Datamodel.xml 

Upgrade in a Customized Environment 

The key points that need to be considered for upgrades in a customized environment are as 

follows: 

 In cases of addition to primary key or not null column additions, data of these tables will be 

backed up and deleted. 

 If there was any addition or change in the out of box seeded data, which clashes with the 

primary key of the new version, then this can lead to conflict of the data due to unique 

constraints. This will eventually halt the normal functioning of the application. 

 All DB objects modified will be over written with the new code and any customizations will 

be lost. 

 As part of data migration, only the columns which are available as part of the out of box 

data model will be migrated. The remaining will not be restored. 

Post Upgrade Activities 

For more information on the data migration activities, refer to the 

OFS_Basel_Regulatory_Capital_Analytics_Upgrade5.3_6.0.0.0.0_Data_Migration_Guide. 

3.2.2 Procedure for First Time Installation in GUI Mode  

Refer to the following steps to install OFS Basel Regulatory Capital Analytics v6.0.0.0.0 without 

OFSAAI v7.3.2.2.0. 

Step 1 

To begin with the OFS Basel Regulatory Capital Analytics installation, execute Setup.sh. 
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Step 2  

 

Upon invoking the installer, the Introduction screen displays the pre-requisites for installation.  

Ensure that the pre-requisites are satisfied before you proceed.                                                        

Step 3 

Select the option Stand Alone and click Next. 
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Step 4 

Specify the installation directory. 

 

Step 5 

Choose the log mode for this installer. If Debug is selected, the Passwords will be printed in the 

Log File. 
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Click Next. 

Step 6 

Specify the Config and Atomic Schema details as follows: 

 User ID 

 Password 

 JDBC URL 

Click Next. 
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Step 7 

Select the Jurisdictions to install the product. 

 

 Note:  

You can select one or more jurisdictions. 

Step 8 
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You have to specify segments for selected jurisdictions. 

 

Step 9 

The Installer Summary Screen is displayed as follows: 
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Step 10: 

 This panel displays the installation process. Wait for the installation process to be completed 

before you proceed further. 

 

Step 11 

The following screen displays the completion of installation of the OFS Basel Regulatory Capital 
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Analytics Setup. 

Click Done to exit 

.  

3.3 OFS Basel Regulatory Capital Analytics Version 6.0.0.0.0 Installation 
with OFSAAI 7.3.2.2.0 

This section is applicable if OFS Basel Regulatory Capital Analytics is being installed in the 

following environment: 

 Installation of OFS Basel Regulatory Capital Analytics with OFSAAI and with the OFS 

Basel Regulatory Capital Application. 

 Installation of OFS Basel Regulatory Capital Analytics with OFSAAI and without OFS 

Basel Regulatory Capital Application. 

If the OFS Basel Regulatory Capital Analytics is being installed with OFS Basel Regulatory Capital 

application v6.0.0.0.0, then the OFS Basel Regulatory Capital Analytics data model needs to be 

merged with the OFS Basel Regulatory Capital application v6.0.0.0.0 data model and then used 

for model upload. 

If OFS Basel Regulatory Capital Analytics is installed with OFSAAI and without OFS Basel 

Regulatory Capital application, then all the steps provided in this section are applicable, except 

model upload which should be processed using OFSAAI by generating the ERwin xml file 

(repository mode).  

3.3.1 Procedure for Basel Regulatory Capital Analytics Installation in GUI mode 

OFSAAI consists of components that are installed in Web, Application (App), and Database (DB) 

layer.  Hence, if you have installed OFSAAI 7.3.2.2.0 in a multi-tier architecture, the OFS Basel 
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Regulatory Capital Analytics (Basel Analytics) installer must be invoked on the machines that host 

the OFSAAI Application and Database tier.   

For a single-tier installation, the installer is required to be invoked only once on the machine that 

hosts all the OFSAAI tiers.   

This section describes the installation process where the three product setup components are 

installed on separate machines. Machine A will be used to install Product Application Layer 

components, Machine B will be used to install Product Database Layer components. 

Note: 

This section is applicable if OFSAAI v7.3.2.2.0 is installed on Oracle 11g on separate machines A 

and B respectively. 

Refer to section on “Silent Installation”, if a silent installation is required. 

Machine A – Product App Layer 

Step 1 

To begin OFS Basel Regulatory Capital Analytics installation, execute Setup.sh. 

 

Step 2 
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Upon invoking the installer, the Introduction screen displays the prerequisites for installation.  

Ensure that the prerequisites are satisfied before you proceed.   

Step 3 

Choose the option On OFSAAI and click Next. 

 

Step 4 

Choose the log mode for this installer. If Debug is selected, the passwords will be printed in the log 

file. 
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Step 5 

Provide the 9 digit Customer Identification Number provided during the OFSAAI installation.  

 

Click Next to continue. 

Step 6 

The Pre Setup Information screen requests for setup information.   

Select the appropriate OFSAAI layer that has been installed on the machine.  
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Example AppLayer 

 

Note: 

The App layer should be installed before the installation of DB layer. 

For a single-tier OFSAAI v7.3.2.2.0 installation, you must select App Layer and DB Layer.  For a 

multi-tier OFSAAI v7.3.2.2.0 installation, select the corresponding layer installed on the machine.   

Step 7 

This panel seeks infromation on whether a new infodom has to be created or the existing infodom 

to be used for installation. Choose the desired option. 
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Click Next to continue. 

Step 8 

If the option New Infodom is selected in the previous panel, then the following panel is displayed 

which seeks information on details relating to creating infodom. 

Step 8-i 

 Specify a DB name for the new infodom.  

 Make a TNS entry with the DB name specified in the tnsname.ora file in the oracle server. 

 Enter the newly created atomic schema user name, password, jdbc url in relevant fields. 

Click Next to continue. 
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Step 8-ii 

If the option New Infodom is selected in the previous panel, then the following panel is displayed  

(following the panel displayed in Step 8-i) which seeks further information to create infodom: 

 Specify the name and description of the new infodom to be created.  

 Specify a segment name to be created. 

 Specify the application server and database server log path for infodom maintenance. 

Note:  

Segment name should not exceed 10 Characters.  
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Note: 

The OFSAAI user is mapped to a role. These roles identify the user with Add/Modify and/or Read 

permissions for Basel Analytics metadata.   

Click Next to continue.  

Step 8-iii 

If the option New Infodom is selected, then the following panel is displayed (following the panel 

mentioned in Step 8-ii) which displays the pre-infodom creation details. Check and verify all the 

details before proceeding to the next step. 
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Click Next to continue creation of information domain.  

Step 9 

If the option Existing Information Domain is selected in Step 7, then update the following details in 

the screen prompt that is displayed: 

 Select the Information Domain name 

 Enter segment code. 

 Enter the application schema’s TNS name. 

Click Next. 

 

 

 



 
Installation Manual 

Oracle Financial Services Software Confidential - Restricted  
 

 

Step 10 

Select the jurisdiction to install Basel Analytics. 

 

 
Note: You can select one or more jurisdictions to install the respective scripts. 

Step 11 

Specify the segments for the selected jurisdictions. 
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Step 12 

This screen displays the pre-installation summary. Verify all details and click Install to proceed. 

 

Step 13 

This panel displays the installation process. To proceed further, wait for the installation process to 

be completed. 
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Step 13 

The following screen displays the completion of installation of the OFS Basel Regulatory Capital 

Analytics Setup. 

Click Done to exit. 

 

 

Machine B – Product Database Layer 
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Step 1 

To begin with OFS Basel Regulatory Capital Analytics installation, execute Setup.sh. 

 

Step 2 

 

Upon invoking the installer, the Introduction screen displays the pre-requisites for installation.  

Ensure that the pre-requisites are satisfied before you proceed.   

Step 3 
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Select the option On OFSAAI since you are installing on OFSAAI. 

 

Step 4 

Choose the log mode for this installer. If Debug is selected, then the Passwords will be printed in 

the Log File. 

Click Next to proceed. 
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Step 5 

Provide the 9 digit Customer Identification Number provided during the OFSAAI installation.  

 

Click Next to continue. 

Step 6 

The Pre Setup Information screen requests for setup information.   

Select the appropriate OFSAAI layer that has been installed on the machine.  

Example Database Layer 



 
Installation Manual 

Oracle Financial Services Software Confidential - Restricted  
 

 

Along with the appropriate OFSAAI layer, choose Administrative Reports to configure the 

Administrative Reports application.  

Note: 

For a single-tier OFSAAI v7.3.2.2.0 installation, you must select App Layer and DB Layer.  For a 

multi-tier OFSAAI v7.3.2.2.0 installation, select the corresponding layer installed on the machine.   

Step 6 

The following panel is displayed, wherein you can select the infodom from list of infodoms present 

in the setup, enter segment code and enter the application schema’s TNS name. 

Segment code should not exceed 10 characters. 

 



 
Installation Manual 

Oracle Financial Services Software Confidential - Restricted  
 

 

Step 7 

Select the Jurisdiction to install. 

 

 

Note: You can select one or more jurisdictions to install the respective scripts. 

Step 8 

You have to specify segments for selected jurisdictions. 
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Step 9 

This panel displays all the pre-installation summary. Verify all details and proceed. 

Click Install to proceed. 

 

Step 10 

This panel displays the installation process. To process further, wait till the installation process is 
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completed. 

 

Step 11 

The following screen displays the completion of installation of the OFS Basel Regulatory Capital 

Analytics Setup. 

Click Done to exit. 
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3.4 Procedure for Basel Regulatory Capital Analytics Installation in Silent 
Mode 

Silent installation is achieved through a properties file [Silent.props] that must be updated with 

proper values, before attempting to install using the silent mode. 

Installing in Silent Mode 

 Edit the file Silent.props and specify the parameters as per the requirements 

 On the UNIX Command prompt, execute the following command 

o “Setup.sh SILENT” 

 Refer to the console log [or the file preinstall.log] for any error messages. 

The following table lists all the properties that need to be specified: 

Property 
Name 

Description 
of Property 

Permissible 
values  

Comments Without OFSAAI 
(OFSAAI_MODE=1
) 

LOG_MODE Specify 
mode for 
logging 

1  =  Debug Optional Required 

0  =  General Default : 0 

CUSTOMER
_ID 

Specify 
Customer id 
provided 
while 
installing 
OFSAAI 

Not 
Applicable 

Mandatory Not Required 

OFSAA_MO
DE 

Specify 
mode of 
installation 
that is, 
with/without 
OFSAAI 

0 = With 
OFSAAI 

Mandatory Required 

1 = Without 
OFSAAI 

INSTALL_DI
R 

Specify the 
installation 
directory 

Not 
Applicable 

Mandatory only if 
OFSAAI_MODE = 1 

Required   

CONF_USE
R 

Specify the 
configuratio
n schema 
user id 

Not 
Applicable 

Mandatory only if 
OFSAAI_MODE = 1 

Required   

CONF_URL Specify the 
configuratio
n schema 
JDBC url 

Not 
Applicable 

Mandatory only if 
OFSAAI_MODE = 1 

Required   

INSTALL_D
B 

Install 
database-
tier 
components 

0 = No Default : 0 Not required  

1 = Yes 

INSTALL_A
PP 

Install 
Application-
tier 
components 
be installed 

0 = No Default : 0 Not required  

1 = Yes 
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Property 
Name 

Description 
of Property 

Permissible 
values  

Comments Without OFSAAI 
(OFSAAI_MODE=1
) 

INFODOM_
NAME 

Specify 
information 
domain 
(infodom) 

Not 
Applicable 

Mandatory Not required  

SEGMENT_
CODE 

Specify 
segment 
code 

Not 
Applicable 

Mandatory Not required  

Segment Code should not 
exceed 10 characters 

INFODOM_
TYPE 

Specify new 
infodom or 
existing 
infodom 

0 = New # Specify Infodom Type Not required  

1 = Existing Mandatory if this an App 
Layer Installation and option 
selected for 
INSTALL_APP=1 

APPL_TNS Specify TNS 
Name of the 
Infodom 
database 

Not 
Applicable 

MANDATORY Not required  

APPL_USE
R 

Specify 
User-id of 
the 
Database 
Schema for 
new 
Infodom 

Not 
Applicable 

# Mandatory if this an App 
Layer Installation and  the 
user wants to create a new 
infodom 

Required 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

 

APPL_PWD Specify 
Password  
of the 
Database 
Schema for 
new infodom 

Not # Mandatory if this is an App 
Layer Installation and the 
user wants to create a new 
infodom. 

Required 

Applicable # Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

 

      

APPL_URL Specify 
JDBC 
Connection 
String of the 
Database 
Schema for 
new 
Infodom 

Not 
Applicable 

# Mandatory if this an App 
Layer Installation and the 
user wants to create a new 
infodom 

Required 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

 

INFODOM_
DESC 

Specify 
description 
for the 
Database 
Schema for 
new infodom 

Not 
Applicable 

# Mandatory if this an App 
Layer Installation and you 
want to create a new 
infodom. 

Not required  

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

APPFTP_L
OG_PATH 

Specify 
Infodom 
Maintenanc
e log path(to 

Not 
Applicable 

# Mandatory if this an App 
Layer Installation and the 
user wants to create a new 
infodom 

Not required  
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Property 
Name 

Description 
of Property 

Permissible 
values  

Comments Without OFSAAI 
(OFSAAI_MODE=1
) 

be created) 
for the new 
Infodom for 
applayer 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

DBFTP_LO
G_PATH 

Specify 
Infodom 
Maintenanc
e log path(to 
be created) 
for the new 
Infodom for 
DBLayer 

Not 
Applicable 

# Mandatory if this an App 
Layer Installation and if the 
user wants to create a new 
infodom 

Not required  

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

BIS_TO_BE
_INSTALLE
D 

Update if 
you want to 
install BIS 

0 = No, 1= 
Yes 

Mandatory Required 

FFIEC_TO_
BE_INSTAL
LED 

Update if 
you want to 
install 
FFIEC 

0 = No, 1= 
Yes 

Mandatory Required 

IFSB_TO_B
E_INSTALL
ED 

Update if 
you want to 
install IFSB 

0 = No, 1= 
Yes 

Mandatory Required 

CBRC_TO_
BE_INSTAL
LED 

Update if 
you want to 
install CBRC 

0 = No, 1= 
Yes 

Mandatory Required 

FINMA_TO_
BE_INSTAL
LED 

Update if 
you want to 
install 
FINMA 

0 = No, 1= 
Yes 

Mandatory Required 

BIS_SEGM
ENT_CODE 

Specify 
name of BIS 
Segment 

Not 
Applicable 

# Mandatory, If 
BIS_TO_BE_INSTALLED 
value is 1 

Required 

USA_SEGM
ENT_CODE 

Specify 
name  of 
FFIEC 
Segment 

Not 
Applicable 

# Mandatory, If 
USA_TO_BE_INSTALLED 
value is 1 

Required 

IFSB_SEGM
ENT_CODE 

Specify 
name  of 
IFSBC 
Segment 

Not 
Applicable 

# Mandatory, If 
IFSB_TO_BE_INSTALLED 
value is 1 

Required 

CBRC_SEG
MENT_COD
E 

Specify 
name  of  
CBRC 
Segment 

Not 
Applicable 

# Mandatory, If 
CBRC_TO_BE_INSTALLED 
value is 1 

Required 

FINMA_SE
GMENT_CO
DE 

Specify 
name  of 
FINMA 
Segment 

Not 
Applicable 

# Mandatory, If 
FINMA_TO_BE_INSTALLE
D value is 1 

Required 

 

3.5 Post Installation Activities 
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For OFSAAI Server Memory Configuration the OFSAAI Server is started using reveleusstartup.sh. 

This file can be edited for setting customized memory settings and garbage collector settings 

depending on the available hardware configuration.  

Once the installation of OFS Basel Regulatory Capital Analytics v6.0.0.0.0 is completed, you must 

perform the following steps. 

 Check the log file (The path and file name specified in the log4j.xml). 

 Ignore the following errors in the log file: 

o Error: ORA-02260: table can have only one primary key. 

o Error: ORA-00955: name is already used by an existing object. 

o Error: ORA-00001: unique constraint (<<UNIQUE KEY NAME>>) violated.  

o Error: ORA-02275: such a referential constraint already exists in the table. 

o Error: ORA-01430: column being added already exists in table. 

o Error: ORA-02303: cannot drop or replace a type with type or table dependents. 

 For with OFSAAI installation: Copy the Repository, Images, and Catalog file from the 

$FIC_HOME/BASELBI/ and place it in the Repository folder where OBIEE is installed.  

 For standalone installation (without OFSAAI): Copy the Repository, Images, and Catalog 

file from <Installation Dir>/BASELBI/ and place it in the Repository folder where OBIEE 

is installed. 

If you encounter any problems during the installation activities, contact OFSAA Support at 

https://flexsupp.oracle.com/. 

. 

https://flexsupp.oracle.com/
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4 OFS Basel Regulatory Capital Analytics 6.0.0.0.0 
Configuration 

4.1.1 Assumptions 

 If OFS Basel Regulatory Capital product is installed, then the table scripts need not be 

executed as described in Section 4.2.1 of this document    

 If OFS Basel Regulatory Capital Analytics is deployed without the OFS Basel Regulatory 

Capital product, then the table scripts that are provided with the Analytics release should 

be executed in a new and blank database schema (refer Section 4.2.1 and Section 4.2.2 

for more details) 

 The database schema will have proper privileges namely: CONNECT, RESOURCE AND CREATE 

MATERIALIZED VIEW, to execute the above mentioned scripts.  

 Oracle Business Intelligence Enterprise Edition (OBIEE) 11.1.1.6.6 Server for the 

respective operating system is installed 

 Administrator knows how to start/shutdown the OBIEE servers namely; 

o Weblogic Server  

o Oracle BI Server 

o Oracle BI Presentation Server 

o Oracle BI Java Host 

 Administrator knows the OBIEE installation path 

4.1.2 Pre-requisites 

 Backup following OBIEE folders (for existing installation, not required for new installation) : 

o <Installation Path>\middleware\instances\instance1\bifoundation\ 

OracleBIServerComponent\coreapplication_obis1\repository 

o <Installation Path>middleware\instances\instance1\bifoundation\ 

OracleBIPresentationServicesComponent\coreapplication_obips1\catalog\<new 

folder created as part of Installation steps> 

 Server details that is link to OBIEE should be kept in handy 

 Copy the following files or folders from the release kit to the local machine: 

With OFS Basel Regulatory Capital 

 $FIC_HOME/BASELBI/catalog/; this folder has the archived data for dashboard and 

answer (report) related files. Do not unzip these files, as these files are not zip files. 

 $FIC_HOME/BASELBI/repository/OFS Basel Regulatory Capital Analytics 6.0 - Repository.zip; 

which has the Basel.rpd file. Unzip this file in the local machine. 

 $FIC_HOME/BASELBI/Images/OFS Basel Regulatory Capital Analytics 6.0 - Images.zip; 

which has image file which are used in the reports (for new installation). Unzip this file in 
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the local machine. 

 $FIC_HOME/BASELBI/dashboardconfiguration/CreateAppRoles.py; this is a script which 

is used for application role creation (for new installation). 

Without OFS Basel Regulatory Capital 

 <Installation Dir>/BASELBI/catalog/; this folder has the archived data for dashboard and 

answer (report) related files. Do not unzip these files, as these files are not zip files. 

 <Installation Dir>/BASELBI/repository\OFS Basel Regulatory Capital Analytics 6.0 - 

Repository.zip; which has the Basel.rpd file. Unzip this file in the local machine. 

 <Installation Dir>/BASELBI/Images\OFS Basel Regulatory Capital Analytics 6.0 - 

Images.zip; this has image files which are used in the reports (for new installation). Unzip 

this file in the local machine. 

 <Installation Dir>/BASELBI/ dashboardconfiguration/CreateAppRoles.py; this is a script 

which is used for application role creation (for new installation). 

4.2 Configuration Steps 

4.2.1 Script Execution  

  Execute the following scripts (from \Customer Deliverables\Scripts\) in the database: 

 5-ALTER_MATERIALIZED_VIEW_FOR_NOLOGGING_Script.sql (this script is 

provided to disable logging of materialized views and the same can be used as per the 

Bank’s policy). 

5-ALTER_MATERIALIZED_VIEW_FOR_NOLOGGING_Script.sql
 

Execute the following scripts (from \Customer Deliverables\Scripts\) in the command 

prompt: 

 6-REFRESH_MATERIALIZED_VIEW_Script.sql (this script is provided to refresh all the 

materialized views if the data of the base tables have been modified or after loading of 

fresh data). 

 

6-REFRESH_MATERIALIZED_VIEW_Script.sql
 

4.2.2 Server Configuration Steps 

For each release, confirm that the following has been setup. 

a. Add the tnsnames.ora file in the following folder “<Installation Path>middleware 

\Oracle_BI1\network\admin”. The tnsnames.ora file should contain the data-

source connection details used in the connection pool of the RPD. 
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b. Log on to Oracle Enterprise Manager. 

i. Go to Business Intelligence menu located on the LHS of the screen. 

Select coreapplication. 

ii. Go to Deployment located on the last tab. 

iii. Click Lock and Edit Configuration. 

iv. Go to the section Upload BI Repository. 

v. Browse and select the repository. 

vi. Enter the repository password and confirm the same. The repository 

password is “Administrator1”. 

vii. Go to BI Presentation Catalog section. 

viii. Edit the catalog path and remove SampleAppLite (in case of first time 

installation) from the end of the catalog path section and enter Basel as 

the name of the new catalog folder. Make sure that the folder path is 

<OBIEE Installation Path>middleware\instances\instance1\bifoundation\ 

OracleBIPresentationServicesComponent\coreapplication_obips1\catalog\

” 

ix. Click Apply. 

x. Click Activate Changes. 

xi. Click Overview tab. 

xii. Click Restart. 

  

 

 

xiii. Click Confirm to restart all opmn services. 

xiv. Edit the NQSConfig.INI file, found at <Installation 

Path>\instances\instance1\config\OracleBIServerComponent\coreapplicati

on_obis1  to reset the FMW_UPDATE_ROLE_AND_USER_REF_GUIDS 

= NO to YES. 

xv. Add the tag 

<UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> in the 

instanceconfig.xml under the tag <Catalog>, found at <Installation 

Path>\instances\instance1\config\OracleBIPresentationServicesCompone

nt and restart all opmn services. 
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xvi. Check if all the servers are up and running (except Presentation Service). 

xvii. Edit the NQSConfig.INI file, found at <Installation 

Path>\instances\instance1\config\OracleBIServerComponent\coreapplicati

on_obis1  to reset the FMW_UPDATE_ROLE_AND_USER_REF_GUIDS 

= YES to NO and update. 

Set EVALUATE_SUPPORT_LEVEL=2 from 

EVALUATE_SUPPORT_LEVEL=0 and save. 

xviii. Remove the tag 

<UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> in the 

instanceconfig.xml under the tag <Catalog>, found at <Installation 

Path>\instances\instance1\config\OracleBIPresentationServicesCompone

nt and restart all opmn services. 

xix. Restart all opmn services. 

xx. Disable the cache (cache can be enabled once the setup is moved to the 

production mode and on the basis of bank’s requirements).To disable the 

cache, click Capacity Management tab in the Oracle Enterprise 

Manager. Select “Performance” tab within it. Click Lock and Edit 

Configuration button. Un-check the option Cache enabled. Click 

Activate Changes. Restart the servers to activate changes.  

 

 

 

c. Open the RPD by clicking Start Menu > All Programs > Oracle Business 

Intelligence > BI Administration. 
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d. Provide the user detail as weblogic, the password provided at the time of installing 

OBI 11g, and the Repository Password as “Administrator1”  

e. Double click Connection Pool Basel in the physical layer of the RPD as shown in 

the following snapshot: 

 

 

Note:  

When the Oracle BI Server is running on Linux or UNIX and you need to update 

database object settings (such as the database type) or connection pool settings, 

you can copy the repository file to a Windows computer, make the changes using 

the Administration Tool on Windows, and then copy the repository file back to the 

Linux or UNIX computer. 

 

f. Change data source name, user name, and password to the Oracle TNS Name, 

database schema name, and password respectively, as shown in the following 

snapshot. 

Note:  

If Oracle TNS Name is entered in Data Source Name, then TNS details must be 

also present under file - <Installation 
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Path>\Oracle_BI1\network\admin\tnsnames.ora. Services must be restarted after 

addition of TNS details in the above mentioned path. 

 

 

 

g. Similarly, change the details for “BaselTRANS” (database details where scripts 

SessionVariables_Create.sql and SessionVariables_Insert.sql are executed.) 

h. Save the  RPD and close it. 

i. Create a folder named “Basel” (if not created) in the following location “<OBIEE 

Installation Path>middleware\instances\instance1\bifoundation\ 

OracleBIPresentationServicesComponent\coreapplication_obips1\catalog\” (Only 

in case of first time installation) 

j. Restart the opmn services. 

4.2.3 Application Roles 

a. Open a command prompt and navigate to the folder “<OBIEE Installation 

Path>/oracle_common/common/bin/”. 

b. Execute the following command: 

wlst <local file path>/CreateAppRoles.py <username> <password>  t3://<obiee 

server’s ipaddress>:<port no.> 

Example. - wlst d:\BaselRoles\CreateAppRoles.py weblogic weblogic123 

t3://10.184.202.205:7001 
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4.2.4 Dashboard/Answer Reports 

This is applicable from any client machine that is, windows machine. 

a. Start the BI services (if not started) :  

b. Start OBIEE Catalog Manager (Start > Programs > Oracle Business 

Intelligence > Catalog Manager). 

c. Go to Tools > Preferences. 

d. Check Paste ACL > Create and Paste Overwrite > All. 

e. Click Ok. 

f. Select Open Catalog from File menu. 

g. Select the option Online for Type. 

h. Type the link for presentation services that is, Oracle Interactive Dashboard link. 

For example: (http://server’s IP:<port_number>/analytics/saw.dll?) 

i. Give the Administrator User ID and Password, and click OK. 

Note:  

Check section 4.2.6 after un-archiving files for BI Publisher Reports (only for new 

installation). 

1. Configuring Basel 

i. Click the “shared folder” on the LHS pane. 

ii. Select the “Un-archive option” from file menu and un-archive file “OFS 

Basel Regulatory Capital Analytics 6.0 - Basel_Dashboard” (sent as 

release), copied onto the local machine as part of introduction pre-

requisite step, and click OK. 

iii. Create a folder “Answers” under “shared folder”. 

iv. Click the folder “Answers” and un-archive file “OFS Basel Regulatory 

Capital Analytics 6.0 - Basel_Answers” (sent as release). 

v. Re-Start (stop and start) the BI services. 

 

2. Configuring US Reports 

i. Click the “shared folder” on the LHS pane. 

ii. Select the “Un-archive option” from file menu and un-archive file “OFS 

Basel Regulatory Capital Analytics 6.0 - US_Dashboard” (sent as 

release), copied onto the local machine as part of introduction pre-

requisite step, and click OK. 

iii. Create a folder “Answers” under “shared folder”. 

iv. Click the folder “Answers” and un-archive file “OFS Basel Regulatory 

Capital Analytics 6.0 - US_Answers” (sent as release). 

v. Create a folder “BIP_REPORTS” under “shared folder”. 

vi. Click the folder “BIP_REPORTS” and un-archive file “OFS Basel 

Regulatory Capital Analytics 6.0 - US_BIP” (sent as release). 

vii. Re-Start (stop and start) the BI services. 

 

http://URL:%3cport
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3. Configuring FINMA Reports 

i. Click the “shared folder” on the LHS pane. 

ii. Select the “Un-archive option” from file menu and un-archive file “OFS 

Basel Regulatory Capital Analytics 6.0 - FINMA_Dashboard” (sent as 

release), copied onto the local machine as part of introduction pre-

requisite step, and click OK. 

iii. Create a folder “Answers” under “shared folder” (Do not recreate, if 

created in Step iii of Configuring Basel). 

iv. Click the folder “Answers” and un-archive file “OFS Basel Regulatory 

Capital Analytics 6.0 - FINMA_Answers” (sent as release). 

v. Create a folder “BIP_REPORTS” under “shared folder” (do not recreate, if 

created in Step iii of Configuring Basel). 

vi. Click the folder “BIP_REPORTS” and un-archive file “OFS Basel 

Regulatory Capital Analytics 6.0 - FINMA_BIP” (sent as release). 

vii. Re-Start (stop and start) the BI services. 

 

4. Configuring Islamic Banking Reports 

i. Click the “shared folder” in the LHS pane. 

ii. Select the “Un-archive option” from file menu and un-archive file “OFS 

Basel Regulatory Capital Analytics 6.0 - IFSB_Dashboard” (sent as 

release), copied onto the local machine as part of introduction pre-

requisite step, and click OK. 

iii. Create a folder “Answers” under “shared folder” (Do not recreate, if 

created in Step iii of Configuring Basel). 

iv. Click the folder “Answers” and un-archive file “OFS Basel Regulatory 

Capital Analytics 6.0 - IFSB_Answers” (sent as release). 

v. Re-Start (stop and start) the BI services. 

 

5. Configuring CBRC Reports 

o Click the “shared folder” in the LHS pane. 

o Select the “Un-archive option” from File Menu and un-archive file “OFS 

Basel Regulatory Capital Analytics 6.0 - CBRC_Dashboard” (sent as 

release), copied onto the local machine as part of introduction pre-

requisite step, and click OK. 

o Create a folder “BIP_REPORTS” under “shared folder” (Do not recreate, if 

created in Step iii of Configuring Basel). 

o Click the folder “BIP_REPORTS” and un-archive file “OFS Basel 

Regulatory Capital Analytics 6.0 - CBRC_BIP” (sent as release). 

o Re-Start (stop and start) the BI services. 

4.2.5 Installation of Images (only for New Installation) 
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a. Uncompress the file “OFS Basel Regulatory Capital Analytics 6.0 - Images.zip” 

and copy all the  images to  the folder <OBIEE Installation Path>\ 

Oracle_BI1\bifoundation\web\app\res\s_blafp\images 

b. Uncompress the file “OFS Basel Regulatory Capital Analytics 6.0 - Images.zip” 

and copy all the images to  the images folder in  "<OBIEE Installation 

path>\user_projects\domains\bifoundation_domain\servers\bi_server1\ 

tmp\_WL_user\analytics_11.1.1\..\..". The path can be similar to: <OBIEE 

Installation path>\user_projects\domains\bifoundation_domain\servers\bi_server1\ 

tmp\_WL_user\analytics_11.1.1\7dezjl\war\res\s_blafp\images or, <OBIEE 

Installation_path>\user_projects\domains\bifoundation_domain\servers\AdminSer

ver\tmp\_WL_user\analytics_11.1.1\silp1v\war\res\s_blafp\images 

c. Re-Start (stop and start) the BI services. 

4.2.6 BI Publisher Reports (only for New Installation) 

a.   Enter the link for Oracle BI Publisher link. for example:. http://server’s 

IP:<port_number>/xmlpserver 

c. Login with the Administrator User Id and Password. 

d. Click Administration (available at top right of the page). 

e. Click JDBC Connection, available under Data Sources. 

 

f. Click  Add Data Source. 
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g. Enter the following details: 

o Data source name: Enter data source name as “FINMA”. 

o Driver Type: Enter the available database type to connect. 

o Connection String: Enter the HOST, PORT, and SID of database in the 

given format. 

For example. (Oracle 11g Driver) 

(jdbc:oracle:thin:@10.184.200.32:1521:OFSAA) 

o Username/Password: Enter the database User ID and Password. 

 

Click Test Connection. A dialog box “Connection Established Successfully” 

appears. Click Apply. Ignore any other settings. Guest settings can be applied, 

according to the usage. 

h. Similarly add two more data sources with names “ERM” and “CBRC”, as 

described in step e. 

4.3 Post Configuration verification steps  

a. Log into Basel Analytics and verify whether the screen looks the same as in the 

following snapshot: 
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b. Click each of the dashboard links and check if all the links are visible. 

c. Open the RPD and check if the RPD can be accessed online with the 

Administrator user 
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